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Preface

This User’s Guide describes the events that are logged in the Cisco ANA Gateway and how they can be 
viewed.

• Chapter 1, “Introducing EventVision”—Overviews the Cisco ANA EventVision application used 
to view events and describes event categories. 

• Chapter 2, “Getting Started with EventVision”—Describes how to open the Cisco ANA 
EventVision window, and the Cisco ANA EventVision window, including its toolbar and menus.

• Chapter 3, “Viewing Events in EventVision”—Describes the EventVision tabs used for viewing 
system and network events.

• Chapter 4, “Working in EventVision”—Describes how to filter and display view the properties of 
specific events, refresh and export events.

Note Changes to the Registry should only be carried out with the support of Cisco Professional Services.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. This section explains the 
product documentation resources that Cisco offers.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml
v
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Preface
    Documentation Feedback
Product Documentation DVD
The Product Documentation DVD is a library of technical product documentation on a portable medium. 
The DVD enables you to access installation, configuration, and command guides for Cisco hardware and 
software products. With the DVD, you have access to the HTML documentation and some of the 
PDF files found on the Cisco website at this URL:

http://www.cisco.com/univercd/home/home.htm

The Product Documentation DVD is created and released regularly. DVDs are available singly or by 
subscription. Registered Cisco.com users can order a Product Documentation DVD (product number 
DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at the Product Documentation 
Store at this URL:

http://www.cisco.com/go/marketplace/docstore

Ordering Documentation
You must be a registered Cisco.com user to access Cisco Marketplace. Registered users may order 
Cisco documentation at the Product Documentation Store at this URL: 

http://www.cisco.com/go/marketplace/docstore

If you do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Documentation Feedback
You can provide feedback about Cisco technical documentation on the Cisco Technical Support & 
Documentation site area by entering your comments in the feedback form available in every online 
document.

Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

From this site, you will find information about how to do the following:

• Report security vulnerabilities in Cisco products

• Obtain assistance with security incidents that involve Cisco products

• Register to receive security information from Cisco

A current list of security advisories, security notices, and security responses for Cisco products is 
available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real time, you 
can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS) 
feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html
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    Product Alerts and Field Notices
Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release them, 
and we strive to correct all vulnerabilities quickly. If you think that you have identified a vulnerability 
in a Cisco product, contact PSIRT:

• For emergencies only — security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for which 
a severe and urgent security vulnerability should be reported. All other conditions are considered 
nonemergencies.

• For nonemergencies— psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuPG) to 
encrypt any sensitive information that you send to Cisco. PSIRT can work with information that has been 
encrypted with PGP versions 2.x through 9.x. 

Never use a revoked encryption key or an expired encryption key. The correct public key to use in your 
correspondence with PSIRT is the one linked in the Contact Summary section of the Security 
Vulnerability Policy page at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

The link on this page has the current PGP key ID in use.

If you do not have or use PGP, contact PSIRT to find other means of encrypting the data before sending 
any sensitive material.

Product Alerts and Field Notices
Modifications to or updates about Cisco products are announced in Cisco Product Alerts and Cisco Field 
Notices. You can receive Cisco Product Alerts and Cisco Field Notices by using the Product Alert Tool 
on Cisco.com. This tool enables you to create a profile and choose those products for which you want to 
receive information.

To access the Product Alert Tool, you must be a registered Cisco.com user. (To register as a Cisco.com 
user, go to this URL: http://tools.cisco.com/RPF/register/register.do) Registered users can access the 
tool at this URL: http://tools.cisco.com/Support/PAT/do/ViewMyProfiles.do?local=en
vii
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Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The 
Cisco Technical Support & Documentation website on Cisco.com features extensive online support 
resources. In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center 
(TAC) engineers provide telephone support. If you do not have a valid Cisco service contract, contact 
your reseller.

Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and technologies. The website is 
available 24 hours a day at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com 
user ID and password. If you have a valid service contract but do not have a user ID or password, you 
can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification Tool to locate your product serial number before submitting a 
request for service online or by phone. You can access this tool from the Cisco Technical Support & 
Documentation website by clicking the Tools & Resources link, clicking the All Tools (A-Z) tab, and 
then choosing Cisco Product Identification Tool from the alphabetical list. This tool offers three search 
options: by product ID or model name; by tree view; or, for certain products, by copying and pasting 
show command output. Search results show an illustration of your product with the serial number label 
location highlighted. Locate the serial number label on your product and record the information before 
placing a service call.

Tip Displaying and Searching on Cisco.com

If you suspect that the browser is not refreshing a web page, force the browser to update the web page 
by holding down the Ctrl key while pressing F5.

To find technical information, narrow your search to look in technical documentation, not the entire 
Cisco.com website. On the Cisco.com home page, click the Advanced Search link under the Search box 
and then click the Technical Support & Documentation radio button.

To provide feedback about the Cisco.com website or a particular technical document, click Contacts & 
Feedback at the top of any Cisco.com web page.
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Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 and 
S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411
Australia: 1 800 805 227
EMEA: +32 2 704 55 55
USA: 1 800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—An existing network is “down” or there is a critical impact to your business operations. 
You and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operations are negatively affected by inadequate performance of Cisco products. You and 
Cisco will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network is impaired while most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• The Cisco Online Subscription Center is the website where you can sign up for a variety of 
Cisco e-mail newsletters and other communications. Create a profile and then select the 
subscriptions that you would like to receive. To visit the Cisco Online Subscription Center, 
go to this URL:

http://www.cisco.com/offer/subscribe
ix
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• The Cisco Product Quick Reference Guide is a handy, compact reference tool that includes brief 
product overviews, key features, sample part numbers, and abbreviated technical specifications for 
many Cisco products that are sold through channel partners. It is updated twice a year and includes 
the latest Cisco channel product offerings. To order and find out more about the Cisco Product Quick 
Reference Guide, go to this URL: 

http://www.cisco.com/go/guide

• Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo 
merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training, and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• Networking products offered by Cisco Systems, as well as customer support services, can be 
obtained at this URL:

http://www.cisco.com/en/US/products/index.html

• Networking Professionals Connection is an interactive website where networking professionals 
share questions, suggestions, and information about networking products and technologies with 
Cisco experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

• “What’s New in Cisco Documentation” is an online publication that provides information about the 
latest documentation releases for Cisco products. Updated monthly, this online publication is 
organized by product category to direct you quickly to the documentation for your products. You 
can view the latest release of “What’s New in Cisco Documentation” at this URL:

http://www.cisco.com/univercd/cc/td/doc/abtunicd/136957.htm

• World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
x
Cisco Active Network Abstraction EventVision User’s Guide, 3.5.1

OL-10881-01

http://www.cisco.com/offer/subscribe
http://www.cisco.com/go/guide
http://www.cisco.com/go/marketplace/
http://www.ciscopress.com
http://www.cisco.com/ipj
http://www.cisco.com/en/US/products/index.html
http://www.cisco.com/discuss/networking
http://www.cisco.com/univercd/cc/td/doc/abtunicd/136957.htm
http://www.cisco.com/en/US/learning/index.html


 

Cisco Active Network Abs
OL-10881-01
C H A P T E R 1

Introducing EventVision

Welcome to the Cisco Active Network Abstraction EventVision User’s Guide that describes the intuitive 
interface for viewing system events and tickets that are generated within the Cisco ANA system. 

About Cisco ANA EventVision
Cisco ANA EventVision is a GUI application, which serves as a browser for viewing and retrieving 
detailed information about the different types of system events and tickets that are generated within the 
Cisco ANA system. Monitoring Cisco ANA EventVision helps predict and identify the sources of system 
problems, which in turn assists in preventing future problems.

You can configure Cisco ANA EventVision to display the following information:

• Number of events per page (default 50 events).

• Amount of events to be exported to a file.

• Display previous dated events (in weeks).

• Filter options. 

• What information appears in EventVision tabs, such as the Audit tab.

System managers or Administrators periodically review and manage the Events List using the Cisco 
ANA EventVision. In addition, when an event occurs in the Cisco ANA system the details are available 
in Cisco ANA EventVision.

All Administrator activities in Cisco ANA Manage are logged and available in Cisco ANA EventVision. 
For more information on Cisco ANA Manage, refer to the Cisco Active Network Abstraction ANA 
Administrator’s Guide.

Cisco ANA EventVision Overview 
Every event that occurs in the Cisco ANA system and the Cisco ANA Gateway is logged. This includes 
all events that are performed as part of the normal operation of the Cisco ANA system, as well as events 
that may need further attention. Events are categorized and any of these log entries can be viewed in 
Cisco ANA EventVision Events List tabs as follows:

• Audit

• Provisioning

• Security
1-1
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• Service

• Syslog

• Ticket

• V1 and V2 Traps

• System Event

Basic Concepts and Terms

Alarm

An Alarm represents a fault scenario that occurs in the network or management system. Alarms represent 
the complete fault lifecycle, from the time that the alarm is opened (when the fault is first detected) until 
it is closed and acknowledged. Examples of alarms include:

• Link down

• Device unreachable

• Card out

• An alarm is composed of a sequence of events, each representing a specific point in the alarm’s 
lifecycle.

Event

An Event is an indication of a distinct “activity” that occurred at a specific point in time. Events are 
derived from incoming traps or notifications and from detected status changes. Examples of events 
include:

• Port status change

• Route entry drop

• Device reset

• Device becoming reachable

• User acknowledgement of an alarm

Events are written to the Cisco ANA database once and never change.

Event Sequence

An Event Sequence is the set of related events, which composes a single alarm. For example, Link down 
– Ack – Link up. 
1-2
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Figure 1-1 Link Down Example

Typically, a complete event sequence includes three mandatory events:

• Alarm Open (in this example, a Link Down event).

• Alarm Clear (in this example, a Link Up event).

• Alarm Acknowledge (not shown in this example).

Optionally, there can be any number of Alarm Change events, which can be triggered by new severity 
events, affected services update events, and so on.

Correlation by Root-Cause

Root-cause correlation is determined between alarms (namely, between event sequences). It represents 
a causal relationship between an alarm and the consequent alarms that originate from it.

For example, a Card-out alarm can be the root-cause of several Link-down alarms, which in turn can be 
the root-cause of multiple Route-lost and Device unreachable alarms, and so on (a consequent alarm can 
serve as the root-cause of other consequent alarms).

Figure 1-2 Card-Out Example
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Ticket

A Ticket represents the complete alarm correlation tree of a specific fault scenario. It can be also 
identified by the topmost (“root of all roots”) alarm. Cisco ANA EventVision’s Ticket Properties dialog 
box displays only tickets, but allows drilling down to view the consequent alarm hierarchy.

From an operator’s point of view, the managed entity is always a complete ticket. Operations such as 
Acknowledge, Force-Clear or Remove are always applied to the whole ticket. The ticket also assumes 
an overall, propagated severity.

Sequence Association vs. Root-Cause Correlation

It is important not to confuse between the two types of relationships in Cisco ANA alarm management:

• Sequence Association—The association between events, which creates the event sequences 
(namely, alarms). It implements either built-in or user-defined relations (namely, specification of 
the event types composing each sequence). 

• Root-Cause Correlation—The association between alarms (event sequences), which represents the 
root-cause relationship.

The following figure shows how both types of relations are implemented in the ticket hierarchy:

Figure 1-3 Sequence Association and Root-Cause Correlation

In the above figure, the “clouds” represent alarms, which are correlated into a hierarchy according to 
root-cause. Within each alarm is its respective event sequence, representing the lifecycle of the alarm.

EventVision Categories
The EventVision recognizes the following categories of Cisco ANA system events or alarms:

• Audit—These events are related to the running of commands in the Cisco ANA Gateway. 

• Provisioning—These events are related to configuration and provisioning activities.
1-4
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• Security—These events are related to client login and user activity when managing the system and 
the environment.

• Service—These events are related to the alarms that are generated by the Cisco ANA system.

• Syslog—These events are related to the predefined set of syslogs received from the devices by the 
VNEs, which are used to generate the syslog events.

• System—These events are related to the everyday working of the internal system and its 
components. These events may be related to the Cisco ANA and Cisco ANA Gateway resources, 
representing the system log.

• Ticket—These events are related to all of the tickets that were opened in Cisco ANA.

• V1 Trap—These events are related to SNMPv1 traps from the devices by the VNEs, which are used 
to generate the trap events.

• V2 Trap—These events are related to SNMPv2 traps from the devices by the VNEs, which are used 
to generate the trap events.

You can also view all of the events in the All tab, if required. For more information about the All tab 
appearing as one of the EventVision tabs see page 3-1.
1-5
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Getting Started with EventVision

This chapter describes the EventVision application and describes the available viewing options enabling 
you to view system events and tickets that are generated within the Cisco ANA system. 

Note EventVision is available to Administrators only.

• Launching EventVision, page 2-1—Describes how to launch EventVision.

• The EventVision Window, page 2-3—Details the EventVision menu options, including using the 
toolbar buttons to navigate through the application.

• Setting EventVision Viewing Options, page 2-6—Explains how to define the amount time 
constraints for displaying events in the various in the EventVision window. 

Launching EventVision
This section provides instructions for launching the Cisco ANA EventVision application. Cisco ANA 
EventVision is password protected to ensure security. Before you start working with Cisco ANA 
EventVision make sure you know your user name, password, and the Cisco ANA Gateway IP address or 
host name that you require.

Note If a user does not login to the Cisco ANA Manage, NetworkVision or EventVision applications during a 
specified period of time (the default is 30 days) the user’s account will be automatically locked. The 
default period can be changed in the Cisco ANA Manage per user in the Properties dialog box (for more 
information about changing the default period and unlocking an account, refer to the Cisco Active 
Network Abstraction Administrator’s Guide). The period of time is measured from the time the user last 
logged out of any of the Cisco ANA Client applications.

To start Cisco ANA EventVision:

Step 1 From the Start menu, select the Programs folder, then Cisco ANA/Cisco ANA EventVision. 

The login dialog box is displayed:

Step 2 Type your User Name, and Password in the appropriate fields.
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Step 3 Enter the required Cisco ANA Gateway’s information in the Host field, as an IP address or host name,

or

Select a Cisco ANA Gateway from the Host dropdown list.

Note The Cisco ANA Gateway IP address or host name that was used when you last logged in is 
automatically displayed at the top of the Host dropdown list.

Note Make sure that you use the leading IP address (the IP on which the Cisco ANA Gateway was 
configured) when logging in to the system.

Step 4 Click OK. The Cisco ANA EventVision window is displayed (The Event Properties detail pane is not 
displayed by default).

If this is the first time you have logged on, you will see the Ticket tab.

If you are logging in again, you will see the tab that was visible when you logged out of the application.
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The EventVision Window
The Cisco ANA EventVision window displays the events generated in the Cisco ANA system. An 
example of the Cisco ANA EventVision window is displayed below.

Figure 2-1 Cisco ANA EventVision Window

The Cisco ANA EventVision window is divided into the following parts:

• Menu Bar, described on page 2-4.

• Toolbar, described on page 2-5.

• The Events List and Properties pane comprised of tabs, which enable you to view the specific 
events described on the selected page.

1 Menu bar

2 Toolbar

3 Table pane

4 Event Properties pane

5 Status bar

6 EventVision tabs
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You can display the Events List only (without the Event Properties pane), and select the required tab to 
display events, such as Provisioning events only, see page 2-5 for an example.

You can also display the following information using the Cisco ANA EventVision window toolbar and 
menu options:

• Define Cisco ANA EventVision display and configuration options, see page 2-6 for more 
information.

• Display the All tab, see page 3-1 for more information.

• Filter dialog box to (filter-in) display selected lines only,see page 4-8 for more information.

• Selected event properties in a separate window, see page 4-1.

EventVision Menus
This section provides a description of each option available in the Cisco ANA EventVision menus and 
shortcut menus.

File Menu

The File menu enables you to export the information displayed and to exit the application.

• Export—Exports the log event information displayed in the Cisco ANA EventVision window 
according to the criteria defined in the EventVision Options dialog box.

• Open All Tab—Opens the All tab.

Edit Menu

The Edit menu enables you to define a filter for events displayed in the Cisco ANA EventVision window.

Filter—Defines a filter for the events displayed in the Cisco ANA EventVision window according to the 
tab selected. For more information, see page 4-8.

Purge—This option is currently unavailable in this version.

View Menu

The View menu enables you to refresh and navigate through the Cisco ANA EventVision window as well 
as view event properties.

• Refresh—Refreshes the information displayed in the Cisco ANA EventVision window.

• Go To—Navigates to:

– Previous Page—The previous page of events in the Cisco ANA EventVision window.

– Next Page—The next page of events in the Cisco ANA EventVision window.

• Properties—Displays the properties of the selected event, for example, the root cause and source. 
For more information, see the Viewing Event Properties section on page 4-1.

• Details Pane—Displays or hides the Details pane. If an event is selected then the properties of the 
selected event are displayed in the Details pane. 
2-4
Cisco Active Network Abstraction EventVision User’s Guide, 3.5.1

OL-10881-01



 

Chapter 2      Getting Started with EventVision
    The EventVision Window
Tools Menu

The Tools menu enables you to define various options for displaying events in the Cisco ANA 
EventVision window’s Table pane. 

• Change User Password—Enables the user to change the password used when logging in to the 
Cisco ANA Client application suite. The change will take effect the next time that the user logs in 
to the application.

• Options—Defines the display options for the Cisco ANA EventVision window. For more 
information, see the Setting EventVision Viewing Options section on page 2-6.

Help Menu

The Help menu provides information about Cisco ANA EventVision.

• Cisco.com—This option is currently unavailable in this version.

• About EventVision—Displays application information, for example, the version number.

Shortcut Properties Menu

Displays the properties of an event selected in the Event Properties window, see the Viewing Event 
Properties section on page 4-1 for more information.

Color Coding of Events List Severity Icons
The Events List is color-coded according to the severity of the event. An icon is displayed for each event 
(ticket/event) in the EventVision tabs (based on its severity) as follows:

• Red—Critical

• Orange—Major

• Yellow—Minor

• Sky Blue—Warning

• Green—Cleared/Normal/OK

• Dark Blue—Information

EventVision Navigation Toolbar
The Cisco ANA EventVision window contains the following tools in the Navigation bar/Toolbar:

Table 2-1 Cisco ANA EventVision Tools

Button Function

Goes back to the previous page of events in the Cisco ANA EventVision 
window.

Goes forward to the next page of events in the Cisco ANA EventVision 
window.
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Setting EventVision Viewing Options
The EventVision Options dialog box enables you to define the options for displaying events in the Cisco 
ANA EventVision window.

To define Cisco ANA EventVision options:

Step 1 From the Tools menu, select Options. The EventVision Options dialog box is displayed.

The following fields are displayed in the EventVision Options dialog box:

• Keep last filter—Saves the filter criteria defined per event type in the Filter Events dialog box to 
the Cisco ANA Registry. The filter criteria are available the next time you login to Cisco ANA 
EventVision. 

Note Events are not filtered automatically when you next login to Cisco ANA EventVision unless 
the Open using filter option is selected as well.

• Open using filter—If the Keep last filter option is selected, this option applies the previously 
defined filter to the events from the time when Cisco ANA EventVision is opened (the events are 
continuously filtered according to the defined settings even after closing and starting a new session).

• Show … events per page—Enables the user to set the number of events that are displayed per page.

• Export … events in total—Enables the user to set the maximum number of events to be exported 
to a file. 

• Run auto refresh every … sec—Enables you to configure Cisco ANA EventVision to run 
Automatic Refresh according to the defined number of seconds. 

Note Selecting this option displays a warning message asking you to confirm your selection, as 
this option uses rapid refresh on the database, which could slow down other vital database 
options.

Refreshes the events (if a filter is active, the refresh is done according to the 
filter) displayed in the log by querying the database. The log returns to the 
beginning of the list, displaying the events in ascending or descending order 
depending on the order of the current list. Descending order means that the last 
event is displayed first. For more information, see page 4-7.

Displays the Cisco ANA EventVision Filter dialog box enabling you to define 
a filter for the events displayed in the EventVision log. For more information, 
see page 4-8.

Toggles automatic refresh of event data on and off. You define the 
refresh-time period (in seconds) in the EventVision Options dialog box. The 
default is 60 seconds. If a filter is active, the refresh is done according to the 
filter. For more information, see page 2-6.

Displays the properties of the selected event or ticket in the EventVision 
Properties Details pane.

Table 2-1 Cisco ANA EventVision Tools (continued)
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• Events displayed for the last selected number of weeks—Enables you to configure which past 
events to display from the database according to the defined number of weeks.

Step 2 Select the required options by checking the appropriate checkbox(es).

Step 3 Click OK to close the dialog box and save your settings.
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Viewing Events in EventVision

The Events are displayed in an Events List log for each tab. These tabs reflect the different event 
categories and display event information related to the specific event category. The following tabs may 
be selected in the Cisco ANA EventVision window:

• All Tab

• Audit Tab

• Provisioning Tab

• Security Tab

• Service Tab

• Syslog Tab

• System Tab

• Ticket Tab

• V1 Trap Tab

• V2 Trap Tab

The events are sorted according to date, where the latest event is displayed first and the oldest event is 
displayed last. You can define the filter to be used as well as the number of events to be displayed in the 
Events List using the EventVision Options dialog box. For more information see page 2-6. 

The navigation toolbar enables you to navigate through all the Cisco ANA EventVision log record pages.

Each page of the Events List displays the selected amount of events per page as defined in the 
EventVision Options dialog box, such as 50, see the Setting EventVision Viewing Options section on 
page 2-6. You can use the Go To sub-menu options on the View menu or the respective toolbar buttons 
in the toolbar, to navigate between each displayed page.

All Tab
When you launch EventVision, the All tab is not displayed.

You can open this tab, as required, using the Open All Tab option on the File menu. 

Note Opening the All tab may take some time to retrieve information from the Cisco ANA database for all 
category events.
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The All tab displays information about all the events. Additional information specific to the event 
category can be viewed in the Events Properties dialog box or individual category tabs.

The following columns are displayed in the All tab:

• Severity—The severity of the ticket.

• Event ID—The sequential ID number of the event. 

• Short Description—A description of the event, for example, device unreachable.

• Time—The date and time when the event occurred. The time is displayed in the following format 
DAY MM/DD HH:MM:SS YYYY.

• Event Type—The event type, namely, audit, system, ticket, provisioning, syslog, security, service, 
and traps.

Audit Tab 
The Audit tab displays all of the events generated for each command or request in the Cisco ANA 
System, for example, opening EventVision displays the following “GetEvent” in the Audit List:

Figure 3-1 Audit Tab

The following information is displayed in the Audit tab:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the event (the color and type of alarm is displayed in the Properties pane’s Severity field)

• Event ID—The sequential ID number of the event (generated by Cisco ANA).

• Time—Logged and recorded at the time the event happened.

• Command Name—The audit specific command name, prefaced by, for example, such as Get…, 
Update…, Find…

• Command Signature—The actual command executed by Cisco ANA, such as 
com.sheer.framework.

• Command Parameter—This column may be empty, depending on the “real” value and a defined 
audit level.

• Result—The result of the command.

• Originating IP—The IP address of the Client that issued the command.

• User Name—The name of the user who initiated the command.
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• Short Description—An aggregation of portions of the same fields in the Audit Command fields. 

The type of information displayed in the Audit tab can be audited by defining the appropriate registry 
keys and their values. The audit service enables you to audit all the commands executed in the system, 
for example, the Get command can be audited. The Audit tab then displays this information.

The following parameters can be controlled through the Registry :

• Override the default auditing details level

• All or specific users

• Display only specific commands

The available values for these parameters are:

• Concise—Displays all (default) events besides the Command Parameters and Results column 
values

• Disable—The commands will not be logged in the Audit tab Events List

For more information about the Registry Editor, refer to the Cisco Active Network Abstraction Registry 
Editor Guide.

Provisioning Tab
Events displayed in the Provisioning tab are events triggered during the configuration of a device. The 
Cisco ANA sends an event explaining the configuration operation, for example, configure the cross 
connect table in a device. The Provisioning tab displays detailed information specific to this event 
category. It contains events both from the Cisco ANA Command Builder and Cisco ANA Workflow 
Editor. Additional information specific to this event category can be viewed in the Events Properties 
dialog box.

The following additional information is displayed in the Provisioning tab:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the event (the color and type of alarm is displayed in the Properties pane’s Severity field)

• Event ID—The sequential ID number of the event.

• Short Description—A description of the event, for example, Script Show has failed.

• User Name—The name of the user who performed the provisioning operation.

• Time—Logged and recorded at the time the event happened.

• Status—The status, for example, success or fail.

• Source—The VNE key on which the provisioning operation succeeded or failed.

Security Tab
The Security tab displays detailed information specific to this event category. Security events are related 
to client login and user activity when managing the system and the environment. Additional information 
specific to this event category can be viewed in the Events Properties dialog box.

The following additional information is displayed in the Security tab:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the event (the color and type of alarm is displayed in the Properties pane’s Severity field)
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• Event ID—The sequential ID number of the event.

• Short Description—A description of the event, for example, Successful login by root.

• Location—The entity that triggered the event, as a hyperlink that opens the relevant location.

• Time—Logged and recorded at the time the event happened.

• Client IP—The IP address of the client.

• User Name—The user name of the client.

• Client Type—The type of client, for example, NetworkVision or EventVision.

Service Tab
The Service tab displays all of the alarms generated by Cisco ANA, for example, link down. Service 
events are related to the alarms that are generated by the Cisco ANA system. Additional information 
specific to this event category can be viewed in the Events Properties dialog box.

The following additional information is displayed in the Service tab:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the event (the color and type of alarm is displayed in the Properties pane’s Severity field)

• Alarm ID—The sequential ID number of the alarm. 

• Short Description—A description of the event, for example, Route entry restored.

• Location—The entity that triggered the alarm, as a hyperlink that opens the relevant location.

• Time—Logged and recorded at the time the event happened.

Syslog Tab
The Syslog tab displays all of the syslog events. These events are related to the predefined set of syslogs 
received from the devices by the VNEs, which are used to generate the syslog events. Additional 
information specific to this event category can be viewed in the Events Properties dialog box.

The following additional information is displayed in the Syslog tab:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the event (the color and type of alarm is displayed in the Properties pane’s Severity field)

• Alarm ID—The sequential ID number of the alarm.

• Short Description—A description of the alarm, for example, Device configuration changed.

• Location—The entity that triggered the alarm, as a hyperlink that opens the relevant location.

• Time—Logged and recorded at the time the alarm happened.

System Tab
The System tab displays all of the system events related to the everyday working of the internal system 
and its components. These events may be related to the Cisco ANA and Cisco ANA Gateway resources, 
representing the system log. Additional information specific to this event category can be viewed in the 
Events Properties dialog box.
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The following additional information is displayed in the System tab:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the event (the color and type of alarm is displayed in the Properties pane’s Severity field)

• Event ID—The sequential ID number of the alarm.

• Short Description—A description of the event, for example, Dropped Events Report.

• Location—The entity that triggered the event.

• Time—Logged and recorded at the time the event happened.

Ticket Tab
The Ticket tab displays detailed information specific to this event category. A ticket event contains a 
single root alarm (the root-cause alarm can be of any alarm type, for example, syslog, service and so on), 
and all its subsequent correlated alarms. Additional information specific to this event category can be 
viewed in the Events Properties dialog box.

The following additional information is displayed in the Ticket tab:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the event (the color and type of alarm is displayed in the Properties pane’s Severity field).

• Ticket ID—The sequential ID number of the ticket.

• Short Description—A description of the event, for example, Link Down.

• Location—The entity that triggered the ticket, as a hyperlink that opens the relevant location.

• Last Modification Time—The date and time when the ticket was last modified.

• Time—Logged and recorded at the time the first event happened.

• Acknowledged—The status of the ticket that is being handled, namely, true (acknowledged) or false 
(not acknowledged).

• Affected Devices Count—The number of devices affected by the ticket (the source(s) of the alarm 
and their subsequent alarms).

• Correlation Count—Displays the number of correlated alarms included in the ticket. For example, 
if in the Correlation tab of the Ticket Properties, there are 3 alarms correlated to the root-cause 
alarm, then the counter displays the number 3. If there are 2 alarms correlated to the root-cause 
alarm, and each alarm in turn has 2 alarms correlated to it, then the counter displays the number 4. 

• Reduction Count—Displays the number of alarms included in the ticket. For example, nine alarms 
can be viewed in the History tab of the Ticket Properties window, but only a single ticket is 
displayed in the Ticket pane.

• Duplication Count—Displays the number of occurrences of the original root-cause alarm included 
in the ticket. For example, if the ticket was created by a link down root-cause alarm, and then the 
link goes up and down again quickly so that it is included in the same ticket, then the duplication 
counter displays the number 2, as the root-cause alarm occurred twice.

For information about viewing ticket properties, see page 4-2.
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V1 Trap Tab
This event is triggered when the Network Element sends a trap message to the Cisco ANA because of a 
network event, for example, Link Down. The V1 Trap tab displays detailed information specific to this 
event category. Additional information specific to this event category can be viewed in the Events 
Properties dialog box.

The following additional is displayed in the V1 Trap tab:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the event (the color and type of alarm is displayed in the Properties pane’s Severity field)

• Alarm ID—The sequential ID number of the alarm.

• Short Description—A description of the event, for example, enterprise generic trap.

• Time—Logged and recorded at the time the event happened.

• Location—The entity that triggered the trap, as a hyperlink that opens the relevant location.

V2 Trap Tab
The V2 Trap tab displays detailed information specific to this event category. Additional information 
specific to this event category can be viewed in the Events Properties dialog box.

The following additional information is displayed in the V2 Trap tab:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the event (the color and type of alarm is displayed in the Properties pane’s Severity field)

• Alarm ID—The sequential ID number of the alarm.

• Short Description—A description of the event. 

• Location—The entity that triggered the trap, such as a hyperlink that opens the relevant location.

• Time—Logged and recorded at the time the event happened.
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Working in EventVision

This chapter describes how to view, filter and display the properties of specific events, and how to refresh 
and export events.

• Viewing Event Properties, page 4-1 describes how to properties of a specific event type.

• Refreshing the Events List, page 4-7 describes how to manually and automatically refresh the 
Events List.

• Filtering Events, page 4-8 describes how to define a filter for the events displayed in the Events 
List.

• Exporting Displayed Data, page 4-9 describes how to export the currently displayed data from the 
Cisco ANA EventVision table. In addition, it describes how to import the data and view it at a later 
stage.

• Logging Out, page 4-9 describes how to log out of Cisco ANA EventVision.

Viewing Event Properties
Cisco ANA EventVision enables you to view the properties of a specific event type. The Event Properties 
dialog box displays detailed information about the event, for example, the severity and the number of 
affected parties.

For a detailed description of the properties refer to:

• Ticket Tab Properties

• Provisioning Tab Properties

• V1 and V2 Trap Tabs Properties

To view Event Properties:

Step 1 Select the required tab for the specific event type and the event in the Cisco ANA EventVision window.

Step 2 Double-click on the event in the Events List.

or

On the View menu, click Properties, or right-click the event, and select Properties from the shortcut 
menu.

The Properties tabbed window is displayed for the selected event.
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Note Clicking Details Pane in the toolbar displays the properties of the selected ticket or event in the 
Properties Details pane.

The header displays the ID number of the selected event.

Ticket Tab Properties
The properties of a selected ticket can be viewed by displaying the Ticket Properties dialog box. For 
example, you can view alarm severity, correlated alarms, active alarms, alarm history or the source of 
the alarm. For more information about the Ticket tab, refer to page 3-5.

For information about opening the Properties dialog box, refer to page 4-1.

The information displayed in the Ticket Properties dialog box corresponds with the information 
displayed in the Ticket pane of the NetworkVision window. The ID number displayed in the header 
corresponds to the ID number of the ticket selected in the EventVision window.

The Ticket Properties dialog box is divided into the following areas:

• Tabbed Pane

• Toolbar

Tabbed Pane

The Ticket Properties dialog box is divided into the following tabs:

• General—General information about the selected ticket, as described on page 4-2.

• History—The history of the ticket, as described on page 4-3.

• Affected Parties—The services (affected pairs) that are potentially affected (potential impact 
analysis) by the ticket, as described on page 4-3.

• Correlation—All of the alarms that are correlated to the selected ticket, as described on page 4-4.

• Notes—Enables you to add notes to the selected ticket, as described on page 4-5.

• Advanced—All of the affected devices, correlation, duplication and reduction counts for the 
selected ticket. In addition, it provides any other additional information available about the ticket, 
as described on page 4-5.

General Tab

The following fields are displayed in the General tab providing information about the compiled alarm:

• Alarm—The supported root-cause alarm name, for example, Link Down.

• Location—The entity that triggered the root-cause alarm, as a hyperlink that opens the relevant 
location.

• Severity—Displays the severity that was propagated from all the correlated alarms. For more 
information, refer to page 2-5.

• Time—The date and time when the initial root-cause alarm was generated. The time is taken from 
Cisco ANA and is displayed in the following format MM/DD/YY – HH:MM:SS.
4-2
Cisco Active Network Abstraction EventVision User’s Guide, 3.5.1

OL-10881-01



 

Chapter 4      Working in EventVision
    Viewing Event Properties
• Open Alarms—The number of correlated alarms for the ticket that are open. For example, 3 / 4. 
Four relates to the total number of correlated alarms for the ticket. Three indicates the number of 
alarms that have not been cleared, and therefore there is one alarm that is closed.

• Acknowledged—The status of the ticket that is being handled, namely, acknowledged (true) and 
unacknowledged (false).

• Description—The description from the message field.

History Tab

The History tab enables you to display the history of the ticket, including all of the events.

The following columns are displayed in the History tab providing information about the compiled alarm:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the event.

• Alarm ID—The ID number of the alarm that changed the ticket.

• Duplication Count—Displays the number of occurrences of the original root-cause alarm included 
in the ticket. For example, if the ticket was created by a link down root-cause alarm, and then the 
link goes up and down again quickly so that it is included in the same ticket, then the duplication 
counter displays the number 2, as the root-cause alarm occurred twice.

• Short Description—A description of the change in the ticket.

• Reduction Count—Displays the number of alarms included in the ticket. For example, nine alarms 
can be viewed in the History tab of the Ticket Properties window, but only a single ticket is 
displayed in the Ticket pane.

• Location—The entity that triggered the alarm, as a hyperlink that opens the relevant location.

• Time—The date and time when the ticket changed.

Affected Parties Tab

When a fault occurs Cisco ANA automatically calculates the affected parties (automatic impact 
analysis), for example, when a link goes down, and embeds this information in the ticket along with all 
of the correlated faults. You can view a list of all the end-points that are affected and that have lost 
connectivity. For more information about proactive impact analysis, refer to the Cisco Active Network 
Abstraction NetworkVision User’s Guide, Viewing Impact Analysis.

The Affected Parties tab displays the services (affected pairs) that are affected (automatic impact 
analysis) by the ticket. For more information about accumulating affected parties, refer to the 
Cisco Active Network Abstraction NetworkVision User’s Guide, Accumulating Affected Parties.

The Affected Parties tab is divided into two areas, namely, Source and Destination. The Source area 
displays the set of affected elements (A side and Z side). The following columns are displayed in the 
Affected Parties tab providing information about the affected parties:

• Location—A hyperlink that opens the Inventory window, highlighting the port with the affected 
parties.

• Key—The unique value taken from the affected element’s business tag key (if it exists).

• Name—The sub-interface (site) name or business tag name of the affected element (if it exists). For 
more information, refer to the Cisco Active Network Abstraction Managing MPLS User’s Guide.

• Type—The business tag type.
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• IP Address—If the affected element is an IP interface the IP address of the sub-interface (site) is 
displayed. For more information, refer to the Cisco Active Network Abstraction Managing MPLS 
User’s Guide.

• Highest Affected Severity—The same source can be part of multiple pairs, and therefore each pair 
can have different affected severities. The highest affected severity is the highest severity of these 
affected pairs. The affected pair can have one of the following severities:

– Potential—The service may be affected but its real state is not known.

– Real—The service is affected.

– Recovered—The service was recovered after the network fault. This state only applies to 
affected pairs that were previously marked as Potentially Affected or Real Affected.

– N/A—From Links view this indicates not relevant.

When an affected side (a row) is selected in the Source area the selected element’s related affected pairs 
are displayed in the Destination area. 

The following additional columns are displayed in the Destination area table in the Ticket Properties 
window:

• Affected Severity—The severity of the affected pair as calculated by the Client according to the 
rules defined in the Cisco Active Network Abstraction NetworkVision User’s Guide, Accumulating 
Affected Parties.

• Alarm Clear State—An indication for each pair of the clear state of the alarm. The following states 
exist:

– Not Cleared—There are one or more alarms that have not been cleared for this pair.

– Cleared—All of the related alarms for this pair have been cleared.

In addition, you can view a detailed report for every affected pair that includes a list of the events that 
contributed to this affected pair. For more information about viewing a detailed report, refer to the Cisco 
Active Network Abstraction NetworkVision User’s Guide, Viewing a Detailed Report for the Affected 
Pair.

Correlation Tab

The Correlation tab displays all of the alarms that are correlated to the selected ticket. 

Each branch provides a short description of the alarm, a severity icon, ID, location and time of the alarm.

The following columns are displayed in the Correlation tab providing information about the alarm as 
follows:

• ID—The ID number of the event that changed the ticket. The branches can be expanded and 
collapsed in order to hide information as needed.

• Short Description—A description of the change in the ticket. The full description is displayed in 
the lower tab area.

• Location—A hyperlink that opens the Alarm Properties window, highlighting the port with the 
affected parties.

• Time—The date and time the ticket was issued.

• Last Modification Time—The date and time when the ticket changed.

• Reduction Count—Displays the number of alarms included in the ticket. For example, nine alarms 
can be viewed in the History tab of the Ticket Properties window, but only a single ticket is 
displayed in the Ticket pane.
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• Duplication Count—Displays the number of occurrences of the original root-cause alarm included 
in the ticket. For example, if the ticket was created by a link down root-cause alarm, and then the 
link goes up and down again quickly so that it is included in the same ticket, then the duplication 
counter displays the number 2, as the root-cause alarm occurred twice.

The Find field in the toolbar enables you to search for information in the Ticket Properties table.

Notes Tab

The Notes tab enables you to add and save notes for the selected ticket.

To add text, enter text in the Notes field and click Save Notes. The new text is added to any previously 
existing text.

Note Save Notes is only enabled when text is entered in the Notes field.

Note The text cannot be edited or removed once you have saved the notes.

Advanced Tab

The Advanced tab enables you to view all of the affected devices, correlation, duplication and reduction 
counts for the selected ticket. In addition, it provides any other additional information available about 
the ticket. 

The following fields are displayed in the Advanced tab providing information about the compiled alarm:

• Successor—A hyperlink to the successor event, for example, port up.

• Correlator—A hyperlink to the correlator alarm.

• Predecessor—A hyperlink to the predecessor event, for example, port down.

• Affected Devices—The number of devices affected by the ticket (the source(s) of the alarm and 
their subsequent alarms).

• Duplication Count—Displays the number of occurrences of the original root-cause alarm included 
in the ticket. For example, if the ticket was created by a link down root-cause alarm, and then the 
link goes up and down again quickly so that it is included in the same ticket, then the duplication 
counter displays the number 2, as the root-cause alarm occurred twice.

• Correlation Count—Displays the number of correlated alarms included in the ticket. For example, 
if in the Correlation tab of the Ticket Properties, there are 3 alarms correlated to the root-cause 
alarm, then the counter displays the number 3. If there are 2 alarms correlated to the root-cause 
alarm, and each alarm in turn has 2 alarms correlated to it, then the counter displays the number 4.

• Reduction Count—Displays the number of alarms included in the ticket. For example, nine alarms 
can be viewed in the History tab of the Ticket Properties window, but only a single ticket is 
displayed in the Ticket pane.
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Toolbar

The Ticket Properties dialog box contains the following tools:

Provisioning Tab Properties
The properties of a selected provisioning event can be viewed by displaying the Provisioning Event 
Properties dialog box. For example, you can view a detailed description of the provisioning event. 

For information about opening the Properties dialog box, see page 4-1. 

For a detailed description of the information displayed in the Provisioning tab, see page 3-3.

The Description area of the Provisioning Event Properties dialog box details all the content of the 
workflow output or the command. If it is a workflow the description includes the execution sequence of 
the workflow and log messages. The execution sequence includes the output of all the scripts executed 
by the workflow and also indicates if workflow rollback has occurred. If it is a command the description 
includes the output of the script.

V1 and V2 Trap Tabs Properties
The properties of a selected V1 Trap and/or V2 Trap alarm can be viewed by displaying the V1/V2 Trap 
Alarm Properties dialog box. For example, you can view the translated Oid and value.

For information about opening the Properties dialog box, see page 4-1.

The V1/V2 Trap Alarm Properties dialog box is divided into the following tabs:

• General—General information about the selected event. For more information about the 
information displayed in the V1 Trap tab, see page 3-6. For more information about the information 
displayed in the V2 Trap tab, see page 3-6.

Table 4-1 Tools in Ticket Properties dialog box

Refreshes the information displayed in the Ticket Properties dialog box.

Acknowledge: Acknowledges that the ticket is being handled and the status of the 
ticket is displayed as true in the Ticket pane and in the Ticket Properties dialog box. 
For more information, refer to the Cisco Active Network Abstraction NetworkVision 
User’s Guide.

Note This button is only enabled if the ticket has not yet been acknowledged.

Clear: Requests the relevant Cisco ANA to remove the faulty Network Element 
from the Cisco ANA networking inventory. In addition, it sets the ticket to Cleared 
severity/status (the icon is displayed in green) and automatically changes the 
acknowledged status of the ticket to true. For more information, refer to the Cisco 
Active Network Abstraction NetworkVision User’s Guide.

Note This button is only enabled if the severity of the alarm is higher than 
Cleared/Normal.

Save Notes: Saves the notes for the selected ticket.

Note This button is only enabled when text is entered in the Notes field of the 
Notes tab.
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• Affected Parties—The services (affected pairs) that are potentially affected (potential impact 
analysis) by the ticket. For more information, refer to page 4-3.

• Advanced—All of the affected devices, correlation, duplication and reduction counts for the 
selected ticket. In addition, it provides any other additional information available about the ticket. 
For more information, refer to page 4-5.

• Trap—General description of V1 and V2 trap information. For more information, refer to the 
section below.

Trap Tab

The Trap tab enables you to view V1 and V2 trap information.

The following fields are displayed in the Trap tab:

• Version—The SNMP version, namely, version-1 or version-2c.

• Community String—The community that the device sends to in the PDU.

• Error Status—The error status, namely, No Error, Too Big, No Such Name, Bad Value, Read 
Only, and Gen Err.

The following columns are displayed in the Values table:

• Translated Oid—A string representation of the Oid. For example, 1.3.6 is translated into 
iso(1).org(3).dod(6).

• Translated Value—A string representation of the Oid value. For example, 1.3 is translated to 
iso(1).org.10.

• Oid—The Oid that is not translated, that is, it is a dot notation representation of the oid, for example, 
1.3.6.1.4.1.9.

• Value—The value that is not translated, that is, it is not represented by string values.

Refreshing the Events List
Cisco ANA EventVision displays current event information in the log. While viewing the log, this 
information is not updated unless you:

• Refresh the list manually

• Use the Auto Refresh option

Note Be sure that when you use the Automatic Refresh option, you configure Cisco ANA EventVision to 
automatically run the refresh option. You define the refresh-time period (in seconds) in the EventVision 
Options dialog box. For more information, refer to page 2-6.

Step 1 To manually refresh the Events List, on the toolbar, click Refresh. 

or

From the View menu, select Refresh. The Events List is refreshed.

Note Click Refresh to redisplay the first page of information, namely, the most recent events.
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Step 2 To automatically refresh the Events List, on the toolbar, click Refresh Table. The Events List is 
automatically refreshed, and older information is moved down the list.

Note When you click Refresh Table the Events List continues to be repeatedly refreshed after the 
defined refresh-time period. The previous setting is maintained, for example, if the order in the 
Events List is ascending and the Events List is refreshed the order will remain ascending. To 
cancel automatic refresh, click Refresh Table.

Filtering Events
The Filter dialog box allows you to filter events according to:

• Severity

• ID

• Date and Time

• Text in the description field

The Filter button toggles to indicate that a filter has been applied.

You may also use the filter to search for information in the Cisco ANA database. 

Note Filter fields are enabled/disabled according to the event type. For example, if a filter is applied to a ticket, 
all the fields are enabled.

To define a filter:

Step 1 From Edit menu, select Filter, 

or

In the toolbar, click Filter. The Filter Events dialog box is displayed.

Step 2 Select and type in the required filter values.

Step 3 Click OK to save your filter settings and apply the filter. The filtered events are displayed in the Events 
List according to the defined criteria.

Note Selecting Keep last filter in the EventVision Options dialog box (refer to page 2-6) saves the currently 
defined filter settings in the Cisco ANA Registry. The next time that the user logs in to the application 
these filter settings are displayed in the Filter Events dialog box. In addition, the events are filtered 
repeatedly for the current session according to the defined settings. 

Note Selecting Open using filter in the EventVision Options dialog box (refer to page 2-6), the events are 
continuously filtered according to the defined settings even after logging out of and in to the application.
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To remove the filter:

Step 1 In the toolbar, click Filter. The Filter Events dialog box is displayed.

Step 2 Click Clear. The selected options in the Filter Events dialog box are cleared.

Step 3 Click OK. All of the events are displayed in the Events List.

Exporting Displayed Data
Cisco ANA EventVision enables you to export the currently displayed data from the Cisco ANA 
EventVision table according to the criteria (total quantity of events) defined in the EventVision Options 
dialog box. The data can then be imported and viewed at a later stage.

To export the table to a file:

Step 1 Select Export from the File menu. The Export Table to File dialog box is displayed.

Step 2 Browse to the directory where you want to save the list.

Step 3 In the File name field, type a name for the list.

Step 4 Click Save. The displayed Events List or row(s) are saved in the selected directory.

Logging Out
When you have finished working with Cisco ANA EventVision you can log out of the application.

To log out of Cisco ANA EventVision, click to close the Cisco ANA EventVision window. The Cisco 
ANA EventVision window is closed.
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